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Version 23.1 Release Notes

This document provides important information regarding new features and changes in your Sage 
Estimating 23.1 software. Read these release notes carefully before installing Sage Estimating 23.1.

Installation Notes

System Requirements

For current information about supported operating systems, Internet browsers, Microsoft® SQL Server®, and 
other software, and about system requirements for servers and client workstations, refer to our 
Knowledgebase article System Requirements for Estimating v23.1.

Note: The system requirements are the minimum for a computer running Estimating with one SQL 
Server instance. Running several other business programs with multiple SQL Server instances may 
affect the performance of your system.

Migration from Estimating (Pervasive) to Versions after v20.1

The migration path from Estimating (Pervasive) to this release is not direct. If you have been using a 
Pervasive-based version of Sage Estimating, you need to:

 1. Migrate (transfer) your existing Pervasive-based data to Estimating (SQL) v20.1.

Important! Sage recommends that you first migrate your data to a test environment to ensure that the 
migration proceeds smoothly. For example, if there are errors in your Pervasive-based data, you have 
an opportunity to correct them in that version before migrating the data to a live environment.

 2. Upgrade your database from v20.1 to this release.

For information about migrating your Pervasive-based data to Estimating (SQL), see the 
version 20.1 Installation and Administration Guide.

Tip: You can continue to operate v20.1 alongside this current release. If you have a large number of 
estimates in Estimating (Pervasive, you can migrate them to version 20.1, export them from version 20.1,  
and then import them later into this version, as needed.
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Installing Sage Estimating

Refer to the Installation and Administration Guide for complete instructions on installing the software and 
migrating or upgrading your data.

Before Installing 

Important!  

 l Microsoft .NET 4.8 is required for Estimating. If it is not already installed on your computer, the 
Estimating installation will require a restart. If you prefer not to restart when installing Estimating, 
first install .NET 4.8 from  the Prerequisites folder (in the Install folder), and then restart your 
computer before installing Estimating. 

If you receive a message about .NET during installation, stop the installation, restart your 
computer, and then run the installation program again.

 l Sage Estimating (SQL)  version 23.1 is compatible with version 21.1 of Sage 300 Construction 
and Real Estate, and later. If you integrate Estimating with Sage 300 Construction and Real 
Estate for Job Cost or Project Management, do not install Sage Estimating (SQL)  version 23.1 
until you install Sage 300 Construction and Real Estate version 21.1, or later.

 l If you are using third-party software that integrates with Sage Estimating, check with the third-
party software vendor to ensure that their software is compatible with version 23.1 before you 
upgrade to this version.
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We've been listening to you!

Sage thanks you for your product ideas! 

In Sage Estimating (SQL) version 23.1, we have incorporated the following customer requests:

 l You can prescribe the type of content that users can enter in user-defined fields. In the Estimating 
Management Console, you can specify field types for user-defined fields in standard databases. The 
type determines the field format and restricts the type of content that users can enter in the fields.

Thank you for this suggestion, Kevin E.

For more information, see "Enforce valid entries for enhanced user-defined fields " (page 16).

 l You can define lists of estimators and project types for standard databases for users to select when 
setting up estimates. Defined entries can help ensure consistency in reports and prevent errors. 

Thank you to all the customers who requested this feature.

For more information, see "Define lists of project types and estimators" (page 16).

 l You can use addon rates greater than 999.999 with most addons (up to 6.5 digits). For example, you 
could use the Project info cost basis to calculate general conditions by month. 

 l You can use more than 192 characters for notes you add to variables. 

Thank you for this suggestion, Jim H.

 l In the Address Book, you can search for a vendor by trade, name, location, and other criteria. 

Thank you for this suggestion, Randy S.

 l When you import an estimate with the same name as an existing estimate, you can choose whether to 
overwrite the existing estimate.

Thank you for this suggestion, Brett S.

 l When exporting estimates to Job Cost, you can create job cost codes "on the fly," so you do not have to 
interrupt the export to create the new cost codes before exporting to Job Cost. 

Thank you for this suggestion, Kevin E.

 l You can choose from new Open Estimate options (in the Options window) to control whether the 
Estimate Catalog displays all its branches in a collapsed state, in the state they were when you last 
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used the Estimate Catalog, or opened to the active estimate when you open the Estimate Catalog from 
the new Open Estimate window, the Manage Estimates window, or the Estimates tab in the Estimating 
Management Console.

Thank you for this suggestion, Mike O.

 l The toolbars in the Estimate catalog in the Manage Estimates window the Estimating Management 
Console and in a new, dockable Estimate Catalog include new buttons for expanding and collapsing 
branches. 

Thank you for all your suggestions, TJ B., Andrew S., Jason S., Daniel D., Amandeep S, Rob H.,  Mike 
O. David W., Daniel D., Randy S., and William S.

 l There is no longer any restriction on the number of limits (levels) you can have in a bond table.  

Thank you for this suggestion, Ruel B.

 l In the Database Variable window, there is no limit to the number of characters you can enter in the Help 
Notes box. 

Thank you for this suggestion, Jim H.

 l When allocating an addon calculated using a Total cost basis, you can now select the categories to 
which to allocate the addon. 

Thank you for this suggestion, Travis M.
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New Features and Enhancements

Sage Estimating version 23.1 introduces the following significant features:

 l Use an updated phase window to work with estimate and database phases more efficiently. 

For more information, see "Work with phases more efficiently" (page 9).

 l Use a new Edit Item window to view all the items in a phase, group phase, or all phases in a single grid, 
and easily add, modify, or remove items. 

For a limited time, if you want to work with items the way you did in previous versions, you can select a 
new Use classic Edit Items window option in the Estimating Options window to continue to do so. (This 
option will not be available in the next version.)

For more information, see Work with items more efficiently.

 l In the Estimating spreadsheet, we replaced the Open Estimate window with a more versatile, 
"dockable" Estimate Catalog that shows all the estimates in your estimates database. Use it to navigate 
to and open an estimate. You can also use it—like the Estimate Catalog in the Estimating Management 
Console—to create a new estimate branch, copy or duplicate existing estimates, export and import 
estimates, and more. 

For more information, see Take advantage of a dockable Estimate Catalog.

 l In the Estimating spreadsheet, we removed a few columns from the default layout for simplicity. We 
found that the category Base Price, Crew, Labor Rate Table, Equip Rate Table, and Phase (not the 
overline) columns were not often used and added unnecessary complexity to the spreadsheet. 

You can still select these columns for spreadsheet layouts, if you need them.

 l In the Estimating Management Console, the Estimates grids in the Estimates and Report Manager 
windows include a new column indicating the branch where the estimate is located in the Estimates 
catalog. 

 l The Security window in the Estimating Management Console includes a number of improvements 
designed to make security easier to use and to give you finer control over access to estimates. 

For more information, see Implement security more easily.

 l If an item is part of a bid grid that has a selected subcontract, Estimating restricts the fields you can 
change so that calculations will be correct if you revert to Self Perform. 
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 l We updated the grids in the following screens, providing the ability to search, filter, and group items (as 
appropriate):

 l In the Configuration Wizard:

 l The database grid on the Data Server tab. 

 l The grid in the Create Database window, which is available when there is no estimate 
database in the instance. 

 l In the Estimating Management Console:

 l The grids in the Tools panes (Backup, Restore, Optimize, and Copy Database) in the 
Estimating Management Console. 

 l Backup? and Restore? column headers. These columns include a checkbox, which 
replaces the [Select All] and [Clear All] buttons.

 l The Companies grid and the People grid in the Address Book. Also, you can now use a 
new [Columns] button to insert several more columns into the grid than with the Field 
Chooser in earlier versions. 

 l The All Estimates grid on the Estimates tab. A new Locked State column displays a lock 
icon for each locked estimate. The estimate catalog also displays a lock icon beside the 
names of locked estimates. 

 l The estimate Permissions grid in the Security, as well as some cosmetic changes in the 
other grids. 

 l We modernized date pickers for the Bid date in the Estimate pane (in the Bid Results 
section) and the Version date in the Standard DB pane (in the General section). 

 l We added an Item Count column for unlocked estimates in estimate grids.   

 l In the Manage Estimates window:

 l Numbers are formatted with the "," separator and "$"currency symbol. 

 l The Estimates grid includes a Locked State column. The column displays a lock icon for 
each locked estimate. The estimate catalog also displays a lock icon beside the names of 
locked estimates. 

 l For Sage Intacct Job Cost integration, the Select Project, Select Sage Intacct Construction Task, 
and Select Sage Intacct Construction Cost Type windows. 

 l For Sage 300 Construction and Real Estate Job Cost Integration, the Select Job, Select Cost 
Code, and Select Category windows. 
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 l We removed the Calculate crew items on base rate only checkbox from addons where it did not make 
sense. 

 l You can use any number of characters for the description when setting up an addon.

 l In the Manage Estimates window and on the Estimates tab in the Estimating Management Console, the 
program automatically saves your sorting, filtering, and grouping choices for the Estimates grid, so that 
the next time you display the grid, you do not have to sort, filter, and group columns again. 

 l We made some improvements to external reporting:

 l You can now limit the number of estimates you generate for the external reports database. For 
example, if you limit the external reports database to 1 estimate, you can use the Get External 
Data feature in Excel to build a report without having to figure out the EstimateId needed to 
extract the data. 

Note: When you limit the external reports database to 1, each time you generate a report for the 
active estimate, any previous estimate is removed.

 l New Totals fields are now available in the external reports database and the report design 
database. 

 l In the External Tools Setup window, if you select the option to generate external reports, you can now 
specify whether to generate data for all configurations or for a specified configuration when you run the 
tool from the External Tools List. 

 l Also, we added support for shared external tools.  

In earlier versions, external programs you added to the External Tools List (on the Advanced tab in 
Estimating) were available only to you. In version 23.1, you can select a new Is Shared option to make 
the tool available to all Estimating users. 

Note: For another user to run a shared program from the External Tools List, it must be installed on 
their computer or shared through a mapped drive. 

 l When you restore a database from a backup copy, the program no longer overwrites existing  
databases. Now, on the Restore Database tab in the Estimating Management Console, you specify the 
name of a new database to which to restore the data. 

 l You can now back up, restore, and copy databases to and from a remote server. 

 l We made working with formula tables and item tables more efficient:

 l Use the new Select Formula Tables window to select a formula table from a grid that you can sort 
and search on. (You open this window in a variety of ways from the Database Formula Tables 
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window and the Item Tables window.) 

 l We simplified the Database Item Table and the Database Formula Table windows. You no longer 
need to open a separate Variable/Formula List window to add or use an item table or a formula 
table. Instead, you use a new row selector and a (for a two-dimensional table) a new column 
selector to select a variable, formula, or formula table directly when creating a new item table or 
formula table.

 l In the Estimating Management Console, the Estimates grids in the Estimates window and in the External 
Report window now display a Contract Amount column. 

The Estimates grid in the Manage Estimates window also displays the new Contract Amount column. 

 l In the Database Editor, you can see descriptions for WBS codes in the selection lists in WBS columns. 
The WBS value you select appears in new WBS Description columns in the grid.  

 l In the Database Editor, when selecting cost codes and categories for integration with Sage Intacct, you 
can see the codes along with their associated descriptions in the selection lists for job cost phases and 
items.   

 l On the Estimating spreadsheet, items must use the same rate table before you can combine them.

 l On the Estimating spreadsheet, you can highlight all the cells in a row by first selecting the row header.

 l When you export items to Excel, descriptions are now left-justified in the Excel spreadsheet. 

 l Row numbers are now visible in the Database Assembly window. 

 l In the Estimating spreadsheet, when you enter cost codes and categories for an estimate that is 
integrated with Sage 300 Construction and Real Estate Job Cost, you can now view a list of codes that 
have been added to the job as well as a list of standard codes. 

 l Numbers and currency in the Manage Estimates grid are formatted with a comma separator and 
currency symbol, as needed. 

 l In the Estimates grid in the Report Manager (in the Estimating Management Console), you can use the 
Generate? column to filter, group, and sort estimates. 

 l We replaced the Estimate Views icons on the Quick Access toolbar with the icon that distinguishes the 
buttons on the ribbon from each other. For example, the Summation sign is now the Quick Access icon 
for Totals. This cosmetic change will make it much easier to distinguish the purpose of these icons on 
the toolbar. 

 l You can choose to print estimate notes on reports. (In the Cover Page Setup window, select Named 
Notes.) 

 l All report options windows now include a [Save As] button, which is available for shared report layouts. 
[Save Layout] is no longer available for shared layouts.  Saving report options automatically fills in the 
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layout name with the name of the current layout so you do not have to retype it. 

Also, the option to share a layout is not available unless you have Manage Shared Layouts permission.

Work with phases more efficiently
In previous versions of Estimating, you used the Estimate Phase window or the Database Phase window to 
display and work with one phase at a time. In version 23.1, you can view all the phase records for an estimate 
or a database in a single grid. 

Note the new Search box and the [Database] button. 

Rather than using cumbersome navigation buttons to scroll through multiple phase records one at a time, you 
can scroll up and down in the grid or you can use the Search box to find a phase quickly. 
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To add a new phase:

 1. Open the Phase window.

 l On the ribbon, from the Elements group on the Data tab, click Phases.

 l On the spreadsheet, select a phase row, right-click, and then click Edit Phase on the shortcut 
menu.

 l In classic view, click Database > Phases.

 2. If you are adding a database phase, click the [Database] button, if it is available. 

Note: If you have an estimate open, the Edit Estimate Phase window opens when you select Phases on 
the ribbon or the Database menu. Always check the window title to confirm whether you are editing an 
estimate phase or a database phase. 

 3. Click [Add]. Estimating adds a new row to the grid beneath the selected row.

 4. In the new row:

 a. Enter the required Phase code, Description , and Unit for the phase.

 b. If you have integrated the estimate with a job cost application, enter the job cost phase.

 c. Optionally, enter a note about the group phase in the Notes column.

 d. If you are adding a group phase, select the Is Group check box.

 5. To set up additional phases, repeat steps 3 and 4. 

To remove a phase, select the row on the grid, and then click [Remove].

To restore a phase that you removed, select the row on the grid, and then click [Restore]. 

 6. When you finish adding phases, click [OK] to save them.

For more information about working with existing phases, see the Estimating help.

Work with items more efficiently
In the new Edit Items window, similar to the Phase window, all items for a selected phase are displayed in a 
grid. Phases are displayed in a panel beside the grid. Details for an item you select on the grid are displayed 
below the grid on the same tabs you are used to using in previous versions.
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Edit several items before saving your changes

In earlier versions, you could edit one item at a time in the Database Item window, and then save your changes 
for that item before you could edit another item. In the Edit Items window, you can edit multiple items and then 
save them all at once. (If you want to work with the old Database Item window for the time being, select the Use 
classic Edit Items window in the Estimating Options window. This option will be removed in the next version.)

Display all the items in your standard database or filter the display by phase 

You can display all the items from all the phases in your standard database in the Edit Items grid. First, select 
the new Show all phases option (available in the Estimating Options window). Then, in the phases pane of the 
Edit Items window, select All Phases. Estimating displays all the items from the standard database in the grid. 

Significantly, you can clear the Show all phases option if you have a very large database, where loading all the 
items from the standard database would be cumbersome and impair the performance of the Edit Items 
window. 

Find items quickly

You can use the new phases pane to navigate to and select the phase that contains items you want to edit. If 
you want to show only certain phases from a long list of phases, you can use the Search box above the Phase 
pane to filter the phases using a keyword. 
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When you select a phase in the Phase pane, only items that belong in the phase appear in the item grid. You 
can use the Search box above the grid to find a particular item quickly from a long item list. You can also click 
most column headings to sort items in ascending or descending order based on that column.

Edit multiple items and view all your changes before saving

When you select an item on the grid, Estimating displays the item record in the Item Details pane below the 

grid. (If the pane is not visible, click the  button below the grid to display it.) The item record includes 
separate tabs for Pricing, Rounding, Links, Subcategories, WBS, and Job Cost (if you set up Job Cost 
Integration) where you record pricing, rounding and waste percentages, linked items, subcategories, and WBS 
codes for item categories.

Note that the old WBS button has been replaced with a new tab in the Item Details pane.

You can edit pricing, WBS codes, and other details, and then select another item without having to leave the 
Edit Items window or scroll through item records one at a time. 

You can edit some item attributes directly on the grid by clicking the list ( ) button for that attribute, and then 
selecting from the list. For example, to change the price code for an item, you click the list button in the Price 
code column, and then select a different code from the Price Code List window.  

You can add items using the convenient [Add] and [Duplicate] buttons. If you want to copy the attributes of an 
existing item, select it on the grid, and then click  [Duplicate]—you will need to change the item to a unique 
number before you can save the new item. To create a new item from scratch, use the  [Add] button.

To delete an existing item, you select it on the grid, and then click the [Remove] button. Removed items remain 
on the grid as Marked for removal and are dimmed until you save your changes.

If you remove an item in error, you can restore it by selecting the item on the grid, and then clicking the 
[Restore] button. 

At the end of a session, before saving your changes, you can click the [Show Edits] button to see all the items 
you changed in all the affected phases. With all your edits showing in the grid, the button changes to [Show 
All]. When you click  [Show All], the grid again displays only the items for the selected phase.

You can save all your changes from your session at one time. You do not need to save changes in one item 
before you begin to edit another item. 

For more information about working with existing items, see the Estimating help.

Take advantage of a dockable Estimate Catalog
Clicking the new Estimates icon on the Home tab of the Estimating ribbon opens an Estimate Catalog window 
that you can float anywhere on your desktop or dock to the spreadsheet. 
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As in the Estimating Management Console, the Estimate Catalog  window displays estimates in branches and 
sub-branches. You can expand branches to display the estimates and sub-branches, and use the arrow keys 
to navigate to estimates that you want to work with. In this window, you can:

 l View a list of the estimates in your instance.

 l Open an estimate you want to work with in the Estimating spreadsheet.

 l Duplicate an existing estimate or copy and paste an estimate.

 l Delete an existing estimate.

 l Rename an estimate.

In the Estimate Catalog toolbar, you can use a new Sync with Active Estimate icon ( ) that expands 
collapsed folders and highlights the active estimate in the Estimate Catalog pane.

Tips: Use the icons in the title bar of the Estimate Catalog   to position the window. 
Select the arrow and then from the menu:

 l To keep the Estimate Catalog  open, do one of the following:

 l Select Floating and then drag the window anywhere on your desktop. You can also select 
the title bar and then drag the window to float it out of a docked pane. 

 l Select Docking and then drag it to dock it to the spreadsheet. 

 l To collapse the window, minimizing the space it uses, select Auto Hide. This option adds a narrow 
tab beside the spreadsheet that is available from any other tab on the ribbon. You can also use the 
pin icon to collapse the window or to redisplay it in the docking pane.

 l To hide the window, select Hide. After hiding the window, you need to use the Estimates icon on 
the Home tab to reopen it.

Implement security more easily 
This section describes extensive improvements to make the implementation of user and estimate security 
easier to understand and use, and to give you finer control over estimate security.

Security pane

We removed the Estimates database name from the top of the Security pane. (The database name still 
appears in the left pane of the Security window.)

Improvements on the Users tab

The Users tab includes the following improvements:
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 l In the Users grid, we relocated the Authentication Type column beside the User ID column. 

 l We removed column grouping for the Users grid. You can use the column headers to filter or sort users 
displayed in the grid. 

 l Roles are now displayed in a grid, which includes a description of each role and indicates (with a check 
mark in the Disabled column) if a role has been disabled.  

You can use the column headers to filter or sort the roles displayed in the grid.

 l In the new Features grid, a check mark beside a feature indicates that a selected user has permission 
for that feature. If you select more than one user, a check mark indicates that all the selected users have 
permission for a feature. A horizontal bar (-) indicates that only some users have permission. 

Improvements on the Roles tab

The Roles tab includes the following improvements:

 l Users are displayed in a new grid, which includes information about each user, including their first and 
last names, group name, and authentication type. 

A check mark beside a user ID indicates that a user is assigned to a role you select in the Roles grid. If 
you select more than one role,  a check mark indicates that all the selected users are assigned to those 
roles. A  horizontal bar (-) indicates that only some users are assigned to the role.

A check mark in the Disabled column indicates that a user ID has been disabled. 

You can use the filters in the column headers to filter or sort the roles displayed in the grid. 

 l In the new Features grid, a check mark beside a feature indicates that a selected user has permission 
for that feature. If you select more than one user, a check mark indicates that all the selected users have 
permission for a feature. A horizontal bar (-) indicates that only some users have permission. 

 l We removed the grouping area for the Roles grid. You can use the filters in the Roles column headers to 
sort or filter roles by columns. 

 l We removed the [Copy existing role] button from the Add Role window. (This functionality did not work 
properly in previous versions.) 

Improvements on the Estimates tab

The Estimates tab includes the following improvements:
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 l You can select new security options to exert finer control over who can view and edit estimates.

In earlier versions, you could select only a single Allow all users to view and edit all estimates option. 
You can now select separate options to allow all users to view and edit all estimates or to allow existing 
users to view or edit new estimates by default, as follows: 

 l Allow all users to view all estimates. This option allows any user, regardless of their role, to view 
any estimate. 

Note: You cannot turn off this option for individual estimates.

If you do not select this option, you can select the new Default allow existing users to view new 
estimates option. This option gives viewing permission to all existing users when you create a 
new estimate, but you can remove viewing permission for individual users on specific estimates. 
You will need to give viewing rights manually to new users, later, if they need it.

If you do not select either option, you need to assign permissions to specific non-administrator 
users for each estimate. (Administrators always have permission to view estimates.)

 l Allow all users to edit all estimates. This option allows any user, regardless of their role, to edit 
any estimate. Selecting this option automatically confers permission to view all estimates. 

Note: You cannot turn off this option for individual estimates.

If you do not select this option, you can select the new Default allow existing users to view new 
estimates option. This option gives editing permission to all existing users when you create a new 
estimate, but you can remove editing permission for individual users on specific estimates. You 
will need to give editing rights manually to new users, later, if they need it.

If you do not select either option, you need to assign permissions to specific non-administrator 
users for each estimate. (Administrators always have permission to edit estimates.)

Important! When you upgrade to version 23.1, if you used the Allow all users to view and edit all 
estimates option in the previous version, these new options are selected by default. This is equivalent to 
having no security for estimates, and may be appropriate if you have a small company. For other 
situations, Sage recommends that you turn these options off and use the default options for new 
estimates to exert finer control over estimate security. 

 l The Estimates grid includes a new column indicating the branch where the estimate is located in the 
Estimates catalog. 

 l You can use a new Search box above the Estimates grid to display estimates that have attributes that 
match your search terms. The results can include text matches from any of the columns in the grid.  

 l When you group estimates by a column, the groups are expanded by default. 
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 l Administrator users no longer appear in the Permissions grid. Because they always have permissions 
for all estimates, you do not need to assign permissions. 

 l The Permissions grid now displays users’ first and last names, authentication types, and whether their 
user IDs are disabled.

 l Also in the Permissions grid, you can use new checkboxes in the headers of the View and Edit columns 
to select or clear these permissions for all users, rather than selecting View or Edit checkboxes one at a 
time for each user. 

Enforce valid entries for enhanced user-defined fields 
You can specify field types for user-defined fields you set up for standard databases in the Estimating 
Management Console. The field type restricts the type of content that users can enter in the user-definable 
fields in estimates that use the standard database. This prevents users from entering values that are not valid 
and ensures that formatting, particularly for dates, is consistent. Then, when you search or report on these 
fields, the consistent data and formatting will provide more meaningful results.

You set up user-defined fields on the Database Information window in the Estimating Management Console, 
as in previous versions. Now, you can specify Text, Date, List, or Numeric as the field type for each user-
defined field, as follows: 

 l If you select Text, users can enter any alphanumeric characters in the field.

 l If you select Date, you can choose from a variety of date formats to specify the date format for the field.

 l If you select List, you can specify a list of values for the field, ensuring that users can only enter 
acceptable values. You can also edit the list, later, adding, renaming, or deleting entries, or rearranging 
their order, as needed.

 l If you select Numeric, users can enter only numeric values in the field.

When you create an estimate based on a standard database, user-definable fields use the field types specified 
for the database as the default. However, you can change the field types for individual estimates in the 
Estimating Management Console

Define lists of project types and estimators
To help ensure that users enter project types and the names of estimators consistently when setting up 
estimates, you can define lists of project types and estimators for each standard database. 

16Sage Estimating (SQL) v23.1 Release Notes



To add lists of valid project types and estimators:

 1. In the Estimating Management Console, from the database Standard Database Catalog, select the 
standard database to which you want to add validation lists.

 2. In the General section of the Database Information pane:

 a. Beside the Project type field, select the [Define List] button.

 b. In the Define List Values window that appears, for each project type you want add to the list, enter 
the project type and then click [Add].

To remove a project type, select it on the list, and then click [Delete].

To rename a project type, select it, click [Rename], type the new name in the Rename dialog box, 
and then click [OK].

 c. When you finish updating the list, click [OK] to return to the Database Information pane.

 3. To add a list of valid estimator names, select the [Define List] button beside the Estimators field, and 
then follow steps 2 (b) and 2 (c).
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Fixes Since the Previous Version

Version 23.1 includes the following fixes:

 l Spreadsheet: 

 l Column headings are no longer obscured when you minimize overlines. 

 l The program works properly when you combine items. 

 l When you change the price of linked items that are used in a bid grid, items in the bid grid are not 
affected if you selected a sub. If the bid grid is Self Perform, the prices of linked items are 
updated. 

 l When you add a new resource to a crew, it appears in the list without your having to close and 
then reopen the window. 

 l When you delete a model that has been used to do a takeoff, assembly headers and details 
generated by that model are also deleted properly. 

 l Assemblies:

 l Items that you add during takeoff now have a proper price and a takeoff unit.

 l After taking off an assembly and then deleting all the items in the assembly, you can still review 
the assembly. 

 l Estimating no longer stops working if you delete all the items in an assembly while the Review 
Assemblies window is open. 

 l Reports:

 l New contacts that you add after creating an estimate now appear on the cover page immediately, 
without your having to close and then reopen Estimating. 

 l Client information that you change in the Estimate Information window is now updated 
immediately on reports. 

 l Hiding columns on the Totals page does not cause the displayed columns to be misaligned on 
printed reports. 

 l You can no longer generate data for locked estimates. This change is to prevent data corruption. 
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 l Estimating Management Console:

 l In the Security window:

 l Assigned features are displayed properly when you select multiple users on the Users tab. 

 l Disabling a role no longer removes that role's permissions, so you do not have to assign 
them again if you re-enable the role. 

 l When an administrator user tries to remove themselves from the Admin role, they now 
receive a message telling them that they cannot do so. 

 l Sage Intacct Integration:

 l A user added to an Intacct company at the entity level, rather than the top level, can now access 
projects (jobs) in Intacct, providing they are assigned a role that includes permission for projects. 

 l When you export entries to Sage Intacct, the resulting entries no longer include excess spaces in 
the memo fields (for example, between an item number and the item description). 

 l Miscellaneous:

 l We removed the Calculate crew items on base rate only option from addons that do not involve 
crews. 
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Revisions to Version 23.1

This section describes enhancements and fixes we have included in revisions to the software since releasing 
version 23.1. 

Note: Each update is cumulative. That is, each successive update includes all the fixes and 
enhancements provided in previous updates as well as additional fixes and enhancements in the current 
update.

Update 2 (Build 23.1.2401.231, February 2024)

Fixes

Update 2 includes the following software fixes:

 l Estimating properly refreshes the details of bond addons when you use the arrow buttons to select 
addons in sequence.

 l You can again renumber bond addons. 

 l When you create a template from a Totals page, any addons from the estimate are no longer duplicated 
after saving the template.

 l You can again edit the takeoff quantity and sub name of an item in a bid grid. 

 l When you highlight a description on a line with a zero amount, Estimating no longer highlights all other 
descriptions for zero-amount items. 

 l Estimating no longer closes after quick takeoff or a formula test when the last variable has help text. 

 l Variable help is displayed correctly on 4K monitors. 

 l When you integrate Estimating with Sage 100 Contractor, the JC Cost Codes List (available for the JC 
Phase column in the spreadsheet) displays the cost code descriptions from Sage 100 Contractor. 

Update 1 (Build 23.1.2312.181, December 2023)

Fixes

Update 1 includes the following software fixes:
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 l When you switch Totals Page templates, database addons load correctly. 

 l In the spreadsheet, you can tab out of the Notes column after you delete a note. 

 l We improved the performance of item tables when you delete items. 

 l When exporting to Job Cost, Estimating no longer exports overline amounts that have no Job Cost 
phase code. 

 l The Edit Phase window now properly determines the job cost setup from the estimate, if needed.  

 l We resolved a performance issue that occurred in the Edit Phase window. 
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Known Issues

Checking in a Standard Database from the Database Editor 
Closes the Database for Concurrent Users
You can work on a Standard database in the Estimating Database Editor while other users perform takeoff 
using the same database in the Sage Estimating program. 

When you try to check in the Standard database while other users have the database open, you receive a 
warning that if you continue to check the file in, there may be unpredictable results for the concurrent users. 

If you continue to check the file in despite the warning, the Estimating program stops working for the other 
users. However, the data is not corrupted and the Estimating program is not damaged.
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Need help?

Get help by: Recommendation* To access:

Reviewing in-
product help

View information about the current window as 
well as procedures for using Estimating.

Click the Help button or icon, 
or press [F1] to display the 
Help topic for that window.

Reading product 
documentation  

View documents and reference material from 
the Estimating Product Documents website.   

Visit the Sage Estimating 
Product Documents page.

Searching the 
Knowledgebase

Search the Sage Knowledgebase, which 
provides 24/7 access to support articles as well 
as the latest software downloads and updates.

Visit the Knowledgebase at 
Sage Knowledgebase.

Asking the 
community

Join industry peers, certified partners, and Sage 
pros online 24/7 at the Sage Community Hub—
the best place to ask questions and share 
product experiences, tips, and tricks.

Visit the Sage Estimating 
General Discussion forum.

Checking the 
latest product 
alerts

Keep up with the latest product information with 
Sage Estimating Announcements at the Sage 
Community Hub forum.

See Sage Estimating 
Announcements.

Submitting a web 
ticket 

Submit your issue directly to our support team 
using Online Case submission.

Visit the Sage Customer 
Portal.

Exploring training 
options

Learn how to harness the full power of your 
software through videos and classes at Sage 
University.

Visit Sage University.
You can also get access to 
Sage University from the 
Estimating File menu by 
selecting Help  > Sage 
University.

*Customer Service hours vary by product line. Access to some resources require an active Sage 
Business Care support plan.

How to Get Help
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http://cdn.na.sage.com/Docs/en/customer/estimating/Documentation.htm
http://cdn.na.sage.com/Docs/en/customer/estimating/Documentation.htm
https://us-kb.sage.com/portal/ss/?tabid=3&searchaliases=custom_us_estimating
https://communityhub.sage.com/us/sage_construction_and_real_estate/f/sage-estimating
https://communityhub.sage.com/us/sage_construction_and_real_estate/f/sage-estimating
https://communityhub.sage.com/us/sage_construction_and_real_estate/f/sage-estimating-announcements
https://communityhub.sage.com/us/sage_construction_and_real_estate/f/sage-estimating-announcements
https://customers.sagenorthamerica.com/irj/portal/anonymous/login
https://customers.sagenorthamerica.com/irj/portal/anonymous/login
https://www.sageu.com/sageestimating/


Submitting Enhancement Requests
We want to hear your suggestions for improving the software. To send us your comments, click on the File 
menu button  and then select Help >  Submit Product Idea.
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